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Copyright and Trademarks 

© 2017 (software, help system, and documentation) by Mettler-Toledo AutoChem, Inc. All rights reserved.  

Neither this document nor the software described herein may be reproduced, transmitted, or disclosed to third 

parties, in whole or in part, in any form or by any manner, electronic or mechanical, without the express 

written consent of Mettler-Toledo AutoChem, Inc. except to the extent provided for by specific agreements. 

Mettler-Toledo AutoChem, Inc. reserves the right to make improvements in this document and the software it 

describes at any time, without notice or obligation.  

iControl, iC Data Center, iC IR, iC FBRM, iC PVM, RC1e, LabMax, iC Safety, EasyMax, OptiMax, ReactIR, iC 

Quant, and ConcIRT are trademarks of Mettler-Toledo AutoChem, Inc.  

Microsoft and Windows are either registered trademarks or trademarks of Microsoft Corporation in the United 

States and/or other countries. 

All other brand and product names are trademarks or registered trademarks of their respective owners.  
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1 Introduction 
iControl installation is wizard-driven. As soon as you start the process from the installation welcome 

page, the wizard guides you through the steps to install iControl, starting with any prerequisite 

components.  

In addition to the installation process, this guide also includes information on administering the 

software, activating licenses, and sharing data among multiple iControl/iC applications. 

2 System Requirements 

Below are the minimum system requirements for the computer where you install iControl. Please 

note that these are the minimum specifications to run the software. Computers with faster 

processors will provide a better user experience. For more information on computer 

recommendations for iC software, please see the iC Software Computer Specification Guide 

available on the Documentation tab at www.mt.com/iC. 

To verify the operating system and hardware configuration, right-click on Computer and review the 

General tab. 

 Minimum Requirements 

 Minimum Specification for iControl RECOMMENDED Specification 

CPU Intel
®
 Core

®
 i5 2.2 GHz or better Intel

®
 Core

®
 i7 Quad Core 2.2 GHz or better 

Memory 4 GB or more RAM 8 GB or more RAM 

Hard Drive SATA 5400 rpm Solid State Drive (SSD) 

Graphics SXGA 1280 x 1024  

with 3D hardware acceleration 

SXGA 1280 x 1024 

with 3D hardware acceleration 

Supported operating systems are 32-bit and 64-bit versions of:  

Microsoft
®
 Windows

®
 7  

Microsoft
®
 Windows

®
 8.1 

Microsoft
®
 Windows

®
 10 

Additional software requirements include Microsoft
®
 Internet Explorer

®
 8.0 Web browser or later, 

Microsoft
®
 Office

®
 2007 or later, and the latest version of Adobe® Reader

®
 or 

other PDF reader.   

http://www.mt.com/iC
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3 Installing iControl RC1e 5.6 

Review the following information prior to installing iControl RC1e 5.6: 

3.1 Necessary User Rights 

NOTE: You need Administrator privileges on the PC in order to successfully install the software. 

To run iControl, normal user privileges are sufficient. 

3.2 Updating iControl RC1e 4.0/5.0/5.3 with iControl RC1e 5.6 

iControl RC1e 5.6 can be installed on the same PC as iControl RC1e 4.0/5.0/5.3, although it is not 

recommended to run both applications at the same time. 

When installing iControl RC1e 5.6, the following data is copied from the previous iControl RC1e 

4.0/5.0/5.3 installation: 

 Equipment database including all device settings such as device names and COM ports 

Note that custom insert types will not get migrated. 

 The last used lab equipment including defined reactor, stirrer, cover, inserts and safety limits 

 Chemical Database 

 Sensors (RTCal, UCB, RD10) including adjustment data 

 Any defined links to other iC applications 

After iControl RC1e 5.6 is installed, you are immediately ready to go with the same defined 

environment as you had in iControl RC1e 4.0/5.0/5.3. Experiments from version 4.0/5.0/5.3 can 

be opened without any data conversion. 

If you still want to work with iControl RC1e 4.0/5.0 AFTER the installation of iControl RC1e 5.6, you 

need to upgrade the Equipment database as follows: 

 Go to the Start Page of iControl RC1e 4.0/5.0 and click on “Configure Equipment” 

 Then click on “Update Database” 

 

 

NOTE:  Before starting the iControl RC1e 5.6 installation, please logout or reboot to close all active 

iControl RC1e 4.0/5.0/5.3 processes. Then proceed to the next section to begin the 

installation process. 

Information about uninstalling iControl RC1e 5.6 can be found on page 27. 
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3.3 Migrating from WinRC 7.x to iControl RC1e 5.6 

iControl RC1e 5.6 can be installed on the same PC as WinRC 7.x, although it is not recommended 

to run both applications at the same time. 

iControl RC1e 5.6 does not automatically migrate and apply any configuration data from WinRC 7.x 

but the Equipment Database file (*.mte) may be used in iControl as a starting point to define the 

equipment. 

If you want to convert existing WinRC 7.11, 7.12, 7.5, 7.6 experiments to iControl RC1e 5.6, then 

you can use the iControl Data Conversion Utility which is available as a separate installer on the 

iControl RC1e 5.6 DVD-ROM in the folder “Data Conversion Utility”. 

NOTE:  Before starting the iControl RC1e 5.6 installation, please logout or reboot to close all active 

WinRC 7.x processes. Then proceed to the next section to begin the installation process. 

3.4 Starting iControl RC1e 5.6 Installation 

NOTE:  It is recommended that you close all open programs prior to starting the installation. 

Please start the setup.exe directly from the download location or installation media. 

The following chapters describe the installation process in detail. 

Notice about prerequisite installations:  

 Some of these prerequisite installations may ask you to reboot the computer. Please do as 

requested and reboot. After you have logged in again, you may need to restart the iControl 5.6 

installer by double-clicking setup.exe. The installer will then continue to the iControl installation. 

NOTE: The iControl Installation wizard will automatically walk you through installation of any 

needed pre-requisites, like .Net Framework 4.6.2 and SQL Server Compact Edition.  

After successful installation of all of the prerequisite installers, the iControl 5.6 main application 

installer appears: 

 

Select Next and move through the wizard steps to install iControl 5.6. 
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3.5 Installed Application Shortcuts 

The iControl RC1e 5.6 installer installed the following shortcuts under your Start menu 

Start > All Programs > METTLER TOLEDO > iControl RC1e 5.6: 

Shortcut  Description 

iControl RC1e 5.6 Main Application. Click this shortcut to start iControl RC1e 5.6 

Release Notes PDF document which describes the known issues with iControl RC1e 

5.6. It is recommended to read this to understand the currently known 

limitations 

Send iControl Logs 

To Customer Care 

This is a utility that gathers the necessary information to provide to 

METTLER TOLEDO Customer Care in case of a support issue 

Temperature Control 

PI Estimator Utility 

For advanced users: This Excel spreadsheet is used to fine tune the PI 

control parameters for your thermostat. Details are described in the 

iControl RC1e 5.6 online help. 

Service Features This is designed for the METTLER TOLEDO Field Service Engineer (FSE) 

The iControl RC1e 5.6 installer also installs a shortcut on your desktop to start the iControl RC1e 

5.6 application. 

3.6 Starting iControl Software 

1. Start the iControl software application by double-clicking the desktop icon or selecting iControl 

RC1e 5.6 from the METTLER TOLEDO program group in the Start menu. 

 
2. The following message indicates the software is running on a trial license: 

NOTE:  If the iCare Software Maintenance subscription or Site License is current on this PC, the 

system will automatically be licensed and the user will not be prompted to activate the 

software. 

 

 If you have a License Key, click Activate Now to proceed with the registration process. 

Instructions begin under 6 iControl/iC Licensing on page 12.  

 If you prefer to remain on the 30-day trial license, click Activate Later. 

NOTE:  The 30-day trial provides access to all iControl RC1e 5.6 features. 
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3.8 Checking for Updates 

If you already have iControl RC1e 5.6 installed and would like to see if you have the latest version 

or release, select Check for Updates from Help menu.  Please note that this check requires internet 

access. 
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3.9 Connecting iControl to iC Data Center 

iC Data Center is a key enabling technology that captures data from all connected instruments at the 

end of an experiment and stores it in a central location. Upon experiment completion several useful 

report files in common formats are automatically prepared and an email is sent to the experiment 

executer with links to the files. iC Data Center enables data sharing among chemists, engineers and 

their colleagues as well as providing a pathway for uploading experiments to electronic lab 

notebooks (eLN) and data management systems. 

 

More information on iC Data Center can be found in the iC Data Center Overview video provided in 

the Tutorial Video section available from the iControl start page. 

To connect iControl to an existing iC Data Center installation, go the main Tools menu and select 

Configure iC Data Center.  Check the checkbox and enter in the full name or IP address of the iC 

Data Center server.  Use the Test Connection button to verify communication. 
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4 UCB and RTCal-Box Firmware Update 

The UCB (Universal Control Box) is an optional hardware component that can be used with your 

thermostat. It allows additional sensors and actors such as dosing pumps and valves to be used in 

conjunction with the reactors.  

NOTE: If you were not already running iControl RC1e 5.0 or 5.3, then to use an existing UCB with 

iControl RC1e 5.6, you will need to update the firmware on this box. 

In the “Firmware” folder underneath the download location or on the installation media of iControl 

RC1e 5.6, you will find the following firmware file that can be used to update the UCB:  

Box-type Version Filename 

UCB 3.4.2 AlrFirmware_iControl_UCB_3_4_2.alrfw 

RTCal 3.4.2 AlrFirmware_iControl_RTCal_3_4_2.alrfw 

To update the UCB firmware: 

1. Open Configure Instruments from your iControl RC1e 5.6
 
Start Page. 

2. Click Add Instrument… and select the UCB instrument.  

3. Select the “Service Tools” tab and click on Download Firmware. You will need to select the 

appropriate serial port for the UCB and browse for the firmware file mentioned above. Click the 

Download to initiate the transfer. 

 

To update the RTCal-Box firmware, open Configure Equipment from your iControl RC1e 5.6 Start 

Page and select the RC1e instrument. In the bottom part of the display where the RTCal-box is 

shown, click on the Download Firmware button on the right. You will need to select the 

appropriate serial port for the RTCal-Box and browse for the firmware file mentioned above. Click 

the Download button to initiate the transfer.  

For more detailed information, refer to the iControl Online help (Search for “Download Firmware”). 
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5 Installation of Multiport Adapter 

The Multiport adapter is used to connect a UCB (Universal Control Box) to a USB port. The USB-

RS422 adapter VSCOM USB-4COM-Plus-Iso works with Microsoft
® 

Windows
® 

10, Microsoft
® 

Windows
® 

8.1 and Microsoft
® 

Windows
®
 7. 

For additional information, the full USB-4COM-Plus-Iso manual can be found here 

http://ftp.vscom.de/multiio/others/info/USB-COM_Plus_Manual.pdf  

In case the driver install wizard does not start automatically, please go to Vision System download 

center http://www.visionsystems.de/downloadcenter.php and select your model (USB-4COM-Plus-

Iso) from the drop down list. 

The following chapters in the manual provide a brief overview on the installation of the multiport 

adapter: 

1. Check settings of the jumper on the USB multiport adapter, as defined below: 

 

2. Plug the cable of the adapter into the USB port on the PC. Windows will start looking for device 

drivers since the adapter is Plug-and-Play. Go through the wizard and if necessary specify the 

appropriate path driver (located in the CD drive directory). The COM Port numbers start with the 

first available. 

3. A reboot of the system is not necessary to complete the installation. 

If you run into problems during the installation, please see the following problem descriptions:  

 Problem Solution 

1 System doesn’t recognize the new 

device 

Go to the Control Panel -> System and Security  

-> System -> Device Manager and open the 

USBDevice (or the USB component with the yellow 

mark) and re-install the respective driver. Then 

subsequently, reboot the PC. 

2 System doesn’t find the 4 COM ports Reboot the PC 

3 COM ports are not found any more after 

unplugging and re-plugging of USB 

adapter 

Reboot the PC 

If this does not help, please refer to your service engineer or contact support at support.rxe@mt.com 

 

http://ftp.vscom.de/multiio/others/info/USB-COM_Plus_Manual.pdf
http://www.visionsystems.de/downloadcenter.php
mailto:support.rxe@mt.com
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6 iControl/iC Licensing 

iControl applications use a licensing scheme to control distribution and use of the software. Below 

are the types of licenses.  

Instrument version—Enables the application to connect to an instrument and run experiments.  

Office version—Enables the user to run the application without a connection to an instrument. 

With this version, experiment data obtained from a computer with an Instrument license can be 

viewed and analyzed. 

Trial version—A trial version is equivalent to an Instrument license with a 30-day time limit.  

Module licenses—Optional add-on modules, allow access to additional features that are 

purchased and licensed separately. 

iCare subscription—A special annual subscription that entitles you to all major and minor 

upgrades and service packs for the Instrument or Office versions of your iC and iControl 

Software as well as priority telephone and email support.  

Site license—Specific companies that have software agreements with METTLER TOLEDO may 

also have a Site License for a particular product or products. Please refer to page 16 for 

instructions on how to install a site license.  

6.1 Using the License Manager to Activate a Single-User License 

NOTE: Although you need to activate your software on a website, the computer where you are 

installing the iControl software does not require an internet connection. You can activate the 

software license using any internet-enabled computer or by contacting customer support at 

iC@mt.com 

The following information applies to users installing a single-user Instrument, Office, or Module 

license. The first time the iC application starts, the system displays the Trial License dialog. Choose 

to Activate Now or Activate Later. 

 

6.1.1 Activate Later – Continue Under a 30-day Trial License  

Click Activate Later in the Trial Version dialog box to defer license activation. You can activate the 

license at any time by selecting License Manager from the iControl software Help menu. A reminder 

link appears on the iControl Start Page to keep you apprised of the trial period.  

 

 

 

  

mailto:iC@mt.com
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6.1.2 Activate Now – Open License Manager and Obtain an Activation Code  

When you click Activate Now, the License Manager dialog box opens. The License Manager 

contains an 8-character Machine ID and an area to input a 25-character Activation Code field in 5-

character segments. Follow the steps below to obtain the code from the AutoChem Customer 

Community Website. The process starts in the License Manager and links to the AutoChem 

Customer Community website to obtain an activation code. Then, you return to the License Manager 

to enter the code and enable the software. 

NOTE: If you purchased iCare at the same time as iControl RC1e 5.6, activate your 5.6 license 

first. Then, follow the steps on page 15 to activate the iCare subscription.  

 

Figure 1 License Manager dialog box 

1. Have your License certificate sheet ready. The sheet is usually a folded A5-size paper certificate 

delivered with the software. 

2. In the License Manager dialog box (Figure 1), click Copy after step 1 to copy the machine ID 

to your clipboard.  

3. Click the link (https://community.autochem.mt.com) after step 2. 

NOTE: Access the AutoChem Customer Community website from any internet-enabled PC—this 

step does not necessarily need to be performed on the PC where the iControl software is 

installed. 

https://communicty.autochem.mt.com/
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Figure 2 AutoChem Customer Community site 

4. Depending on whether or not you have an account, start with one of the following steps: 

If you are a new user, begin by setting up a user account (see page 16). 

If you already have an account, enter your username and password and click Log in under 

User login or click log in from the red prompt box.  

     

5. Click Activate an iControl or iC License from the My Account tab. 

 

6. Enter the Machine ID from the iControl License Manager and the License Key from paper 

certificate.  

 
Figure 3 Activate License web page 
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7. Click Generate Activation Code to produce the code in the text box. Then, click Copy to save 

the code to the clipboard. 

8. Return to the License Manager in the iControl software, and click Paste or type in the activation 

code in step 3. Enter Activation Code.  

 

9. Click Apply Activation Code to complete the activation. You should see a dialog box that 

confirms the activation is complete. 

10. Repeat the process to activate any module licenses on the PC. 

6.2 Activating an iCare Subscription 

The procedure to activate an iCare subscription is similar to that for obtaining an activation code 

from the AutoChem Customer Community website for a single-user license. The 12-character iCare 

Subscription Number is on an iCare Subscription Certificate that shipped with your order.  

1. Login to the METTLER TOLEDO AutoChem Customer Community Website. 

2. Click Activate an iCare Subscription from the My Account tab. 

 

3. In the iCare activation window ( Figure 4), enter the Machine ID from the iControl License 

Manager for the computer that this subscription should be associated with.  

 

 Figure 4 Activate an iCare Subscription window 
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4. Enter the Subscription Number from the certificate sheet. 

5. Click the Activate Subscription button. You should receive a confirmation email message in a 

few minutes that provides some additional information about the program.  

6. The email will also include an iCare Subscription Activation Code that can be entered or pasted 

back into the License Manager dialog box of the iControl software.  

Activating the iCare subscription in the software itself is not required, but if you perform this step, 

then you will not need to update any licensing information if a new iControl version is released 

before the iCare subscription expires. 

6.3 Setting Up a New User Account 

If you do not already have a user account on the AutoChem Customer Community Website, you will 

need to create one before your licenses can be activated. 

1. From the AutoChem Customer Community website (https://community.autochem.mt.com), 

click the Create new account link.  

2. Enter the required information and accept the terms. 

3. Click Create new account at the bottom of the registration form. 

The AutoChem Customer Community website confirms that an email is being sent: 

 

You will receive an email with instructions and a link to confirm your email address and complete 

the new account registration.  

NOTE:  Your website registration will be pending until confirmed by METTLER TOLEDO AutoChem; 

however, you can activate the software by following the link provided in the email. 

 

4. Click the first link to confirm your email. You will go to a one-time login where you create a 

password.  

5. After you change and confirm the password, click Save at the bottom of the page. 

6.4 Installing a Site License 

Most companies do NOT have a site license, so only follow this procedure if specifically directed by 

your organization. 

NOTE:  To use a site license file, the computer must be a member of the company’s named 

domain. If the computer is standalone and not on the network, then METTLER TOLEDO can 

provide an individual activation code. Please contact your site administrator for assistance.  

A Site License is supplied as a file, usually via email and must be loaded into each copy of the 

iControl software in use. 

https://community.autochem.mt.com/
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1. To install the Site License, open the License Manager by selecting it from the Help menu. 

 

2. In the License Manager, click Enable. 

 

3. Click Browse to navigate to the Site License file location. Then, click OK. 

  

The license loads and the software is ready to use.  

4. Repeat on the other computers with iControl installed. 
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7 Security and Setup Guidelines for IT 

This section is intended for IT (Information Technology) departments to help them understand the 

minimal user privileges and general computer setup needed to install and run iControl RC1e 5.6. 

7.1 Installation Privileges 

The installation of iControl RC1e 5.6 requires administrative privileges. 

7.2 Execution Privileges 

To operate iControl RC1e 5.6
 
normal user privileges are sufficient. 

7.3 Folders Access Privileges 

To operate iControl RC1e 5.6, the logged in user needs read access to the following folders 

including all subfolders: 

32-bit Operating System: <Drive>:\Program Files\METTLER TOLEDO 

64-bit Operating System: <Drive>:\Program Files (x86)\METTLER TOLEDO 

To operate iControl RC1e 5.6, the logged in user needs read/write access to the following folders 

including all subfolders: 

<Drive>:\ProgramData\METTLER TOLEDO 

<Drive>:\Users\<UserName>\AppData\Roaming\METTLER TOLEDO 

<Drive>:\Users\<UserName>\AppData\Local\Temp 

7.4 Registry Access Privileges 

To operate iControl RC1e 5.6, the logged in user needs read/write access to the following keys 

including all subkeys: 

HKEY_LOCAL_MACHINE\SOFTWARE\Mettler Toledo 

7.5 Network Access 

When used in conjunction with other iC applications, iControl requires open network ports in order to 

communicate. There are two ports of interest: A UDP port for locating other iC applications (typically on the 

same subnet) and a TCP port for direct connections with other applications.  

The TCP port must be open on the firewall if you wish to use iControl with iC applications. The UDP port is 

not required but having it open it will facilitate identifying other iC applications in order to set up the initial 

connection.  

7.5.1 UDP Ports 

All iControl and iC 4.0 and newer application use UDP broadcasts on the UDP port 1001 (default) 

to find each other. This happens automatically for iC 7.0 and higher versions, but for older versions 

the user must press the “Find METTLER TOLEDO Applications” button in an iC application (in the 

main menu under Tools/Connect to other iC/iControl applications…"). In iControl the broadcast is 

done automatically and does not need to be triggered manually. 

NOTE:  It is not required to have this port open. The UDB broadcast is only used to find and 

exchange the Hostname and TCP port settings to connect the iControl or iC applications. All 

the actual communications are then done on a TCP link. 
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This default UDP port can be changed in the following XML file by setting a different Broadcast Port: 

C:\ProgramData\METTLER TOLEDO\ApplicationInfo.config.xml 

<?xml version="1.0" standalone="yes"?> 

<AppInfos> 

 <AppInfo> 

    <Title>iControlRC1e on LocalHost</Title> 

    <AppType>iControlRC1e</AppType> 

    <Version>5.6.XX.0</Version> 

    <Host>ch03w0713.eu.mt.mtnet</Host> 

    <Path>C:\Program Files\METTLER TOLEDO\iControl RC1e 5.6\iControlRC1e.exe </Path> 

    <Port>3903</Port> 

    <Index>0</Index> 

  </AppInfo> 

  <OtherDefaults> 

    <BroadcastPort>1001</BroadcastPort> 

  </OtherDefaults> 

</AppInfos> 

NOTE:  This file is created when iControl starts up the first time. 

7.5.2 TCP Ports  

By default, iControl communicates with other iControl or iC applications on the network over TCP 

port 3903.  

7.6 Check Power Settings 

On a PC that will be controlling an instrument, you must adjust the power settings to prevent 

interruption of the data collection process. 

7.5.1 Never Go into Sleep Mode 

Search for ‘Power options.’ Set all to Off, Never, or Disabled. 

7.5.3 Disable Hibernation Mode 

Ensure that the ‘Enable hibernation’ option is not selected. 
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7.7 Deployment Files and Dependencies 

An iControl installation has the third-party dependencies listed below. 

Third-Party Dependencies Version Third-Party 

.Net Framework  4.6.2 full  
Microsoft 

 
SQL Server Compact Edition 4.0 

Windows installer  3.1 

An iControl installation deploys the files described below. 

iControl Software Deployments Notes 

Software and instrument drivers deployed to  

 

32-bit Operating System: 

C:\Program Files\METTLER TOLEDO\iControl RC1e 5.6 

C:\Program Files\METTLER TOLEDO\ALRComponents 5.3 

 

64-bit Operating System: 

C:\Program Files (x86)\METTLER TOLEDO\iControl RC1e 5.6 

C:\Program Files (x86)\METTLER TOLEDO\ALRComponents 5.3 

Installation path 

Miscellaneous configuration files deployed to:  

 C:\ProgramData\METTLER TOLEDO\iControl RC1e\5.6 
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8 Sharing Data Between iC/iControl Applications 

Using synthesis workstations controlled by iControl with METTLER TOLEDO analytical probes 

connected to iC software has many benefits. See the tutorial video Using iControl and iC Analytical 

Probes included with iControl for a good summary of how to setup the connection and the benefits 

of using it. 

The simplest way to connect iControl and iC analytical software like iC IR, iC FBRM or iC Raman, is 

to install the applications on the same computer. If this is the case, then proceed directly to section 

8.2 Connecting the iC/iControl Applications.    

If iControl and the iC analytical software are on separate computers then the two PC’s must have an 

Ethernet connection between them, either over the corporate network or a private LAN.  

 
Figure 6 Sharing Data Between Experiments in Real-time 

This section provides a general summary of the steps needed to connect two computers running iC 

software over a corporate network. If the PCs and instruments are connected to each other on a 

private hub or you have difficulties with any of these steps and need additional troubleshooting 

information, then please refer to the full Software Tip Sheet on Sharing Data between iC/iControl 

applications which is available on the AutoChem Customer Community website 

(https://community.autochem.mt.com/index.php?q=iCAppInterop) 

Before starting the steps below, ensure that: 

 The iC and iControl applications on each PC are properly installed and can successfully 

execute an experiment with their respective equipment 

 The two Computers are connected on the same network  

The general approach is to add an exception to the Windows Firewall on each machine and then 

configure iControl and the iC applications to communicate with each other.  

  

https://community.autochem.mt.com/index.php?q=iCAppInterop
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8.1 Configuring the Windows Firewall 

The instructions in this section are only required if the iControl software and the iC analytical 

software are on different computers.  If they are installed on the same PC, this step can be skipped. 

1. On the PC running iControl, click the Start -> Control Panel -> System and Security -> 

Windows Firewall. (or use the start search option for firewall.cpl) 

 

2. Select the Allow a program option. 

 

3. Select the Allow another program button (if this button is not enabled, then you may need to 

first click the Change Settings button) 
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4. Select the Browse option and locate: 

C:\Program Files (x86)\METTLER TOLEDO\iControl RC1e 5.6\iControlRC1e.exe 

  

Note: If you install a different version of iControl, you will need to repeat this process for the 

new version.  

5. Repeat steps 3-4 and add a program exception for: 

C:\Program Files (x86)\METTLER TOLEDO\iControl RC1e 5.6\iControlService.exe. 

6. On the PC running the iC analytical software, repeat steps 1-4 and add an exception for 

appropriate programs such as: 

 C:\Program Files (x86)\METTLER TOLEDO\iC IR 4.3\iCIR.exe 

 C:\Program Files (x86)\METTLER TOLEDO\iC FBRM 4.3\iCFBRM.exe AND  

C:\Program Files (x86)\METTLER TOLEDO\FBRM Server 4.3\FBRMServer.exe 

 C:\Program Files (x86)\Kaiser\iC Raman 4.1\iCRaman.exe 
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7. If the computers involved are located in different subnets, then you must use the 'Advanced 

settings' to modify the firewall rules so that the remote address is not restricted to the local 

subnet. Select the Advanced Settings link to open the Windows Firewall with Advanced Security. 

Then select Inbound Rules and locate the TCP entries for iControl RC1e and iControl Service. 

 

 

Double click each of the highlighted entries and change the scope to allow any network 

connection: 

 

 
 

8.2 Connecting the iC/iControl Applications 

This section describes how to set up the connection in the iC and iControl applications. 
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1. Start both the iC analytical software (i.e. iC IR) and iControl.  

2. In iControl, click Configure Equipment on the start page, click Add Instrument, select the 

appropriate option and click OK: 

 

3. Enter a name for the analytical instrument probe and click OK. If you are using a multiple probe 

instrument with an EasyMax or two OptiMax systems (one probe for each reactor), then you 

will need to do this process twice – adding a new Instrument entry in iControl for each probe. 

 

4. Select the option for the iC analytical software being installed on a different PC and enter the 

computer name or IP address  

 
 

5. Make sure the iC software is running on the other PC and then click the Test Connection button 

to verify communication. 



 

iControl RC1e 5.6 Installation Guide Page 26 of 27  

iC
o
n
tr
o
l 
R
C
1
e
 I
n
st

a
lla

tio
n
  

 

6. If the test is successful, save the configuration. If iControl cannot communicate with the iC 

computer and the firewall has already been updated, then see the more extensive connection 

guide available on the AutoChem Customer Community website: 

 https://community.autochem.mt.com/index.php?q=iCAppInterop  

8.3  Verifying Connection 

To verify that the connection is working for all aspects of the interface, perform the following checks: 

8.3.1 Check that iControl Can Connect to iC  

1. Start a new experiment and include the iC device in the equipment setup 

2. Execute the run and verify that you can start a new iC experiment from the iControl wizard 

3. Verify that the iC experiment starts when the iControl experiment starts 

4. Check that the iC operations can be used in the iControl procedure (change sample 

interval, pause, etc.) 

5. Add iC trends to the iControl Trend Viewer 

6. Try a different experiment that specifies a template file (note that the path for the template 

file should be from the iC application point of view) 

8.3.2 Verify iC Connection to Another iC or iControl Application 

1. Add trends from an open experiment in one application to the other iC applications’ live or 

completed experiment 

2. Verify that live trends from one iC application are correctly updated in a live experiment on 

the other iC application 

If you encounter any issue and need further instructions or troubleshooting ideas, then please refer 

to the full Software Tip Sheet on Sharing Data between iC/iControl applications which is available on 

the AutoChem Customer Community website: 

https://community.autochem.mt.com/index.php?q=iCAppInterop 

 

https://community.autochem.mt.com/index.php?q=iCAppInterop
https://community.autochem.mt.com/index.php?q=iCAppInterop
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9 Uninstalling iControl RC1e 5.6 

Below are instructions to uninstall the current or previous versions of iControl software and the 

prerequisite software applications. 

9.1 Uninstalling iControl RC1e 5.6 Application 

NOTE:  Uninstalling iControl RC1e 5.6 will not uninstall or delete any experiments, equipment 

database, license activation, or user settings—all data is retained. So, after you reinstall 

iControl RC1e 5.6 (or install a future version of iControl) all of your data will be accessible 

again.  

To uninstall the iControl RC1e 5.6
 
application, open Uninstall a Program from the ‘Control Panel’ 

and select the ‘iControl RC1e 5.6’ entry. 

Click Uninstall to start the removal process and follow the instructions in the uninstall wizard. 

9.2 Uninstalling Previous iControl Installations 

When uninstalling a previous iControl installation such as iControl 4.0/5.0/5.3, remove only the 

iControl installation. Do not remove any METTLER TOLEDO ALR Components installations. 

9.3 Uninstalling Prerequisite Software 

Please note that iControl RC1e 5.6
 
requires several prerequisite applications to run. Uninstalling any 

of the prerequisite applications may lead to unexpected behavior in iControl or affect other 

applications installed on the PC. The following table shows the required prerequisites per product: 

 Microsoft .NET Framework 4.6.2  Microsoft SQL Server Compact 4.0 

iControl RC1e 5.6 X X 

9.3.1 Uninstalling Microsoft SQL Server Compact 4.0 

To uninstall Microsoft SQL Server Compact 4.0, open Uninstall a Program from the ‘Control Panel’ 

and select the ‘Microsoft SQL Server Compact’ entry. Then click Uninstall to start the removal 

process and follow the uninstall wizard. 

9.3.2 Uninstalling Microsoft .NET Framework 4.6.2 

NOTE:  Microsoft .NET Framework 4.6 is a basic infrastructure component of your Windows 

operating system and therefore uninstalling it is not recommended. 

To uninstall the Microsoft .NET Framework 4.6.2, open Uninstall a Program from the ‘Control 

Panel’ and select the ‘Microsoft .NET Framework 4.6.2’ entry. Click to start the removal process. 

Follow the uninstall wizard instructions. 

 

 


